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INTRODUCTION
NORTHERN STORAGE REPORTER
The Northern Storage Reporter [NSR] is a state-of-the-art storage reporting application, 
offering detailed reports and drill-down analyses of storage. It is an invaluable help when it 
comes to understanding and analysing the content of your servers: reports are immediately 
available in the client console and you can explore usage, usage patterns and trends on servers, 
of user, file types or volumes. Furthermore, NSR offers a wealth of administrative options that 
are geared at managing storage; and it works smoothly with SAN, NAS, and RAID technologies 
on all Windows Servers.

In concert with Northern Storage Assistant, Quota Server 2005, Northern Chargeback and 
Northern Storage Portal you are able to keep the storage content of your servers in order: you 
can ensure that files end-up where you want them to, make sure that old files, undesired File 
Types or rarely used files are scrapped or kept on secondary storage, and you can even 
implement a cost recovery scheme. 

INSTALLATION
For in depth installation and deployment information please refer to the Deployment Guide, 
found in the Northern Storage Suite installation directory.

SYSTEM REQUIREMENTS
For a list of the system requirements please refer to the Deployement Guide, found in the 
Northern Storage Suite installation directory.

LICENSING
For in depth licensing information please refer to the Deployment Guide, found in the Northern 
Storage Suite installation directory.
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CONCEPTS
The structure of information in Storage Reporter revolves around five key concepts:

Host Groups
Hosts
Volumes
Users
File Types
File Type Groups

HOST GROUP
A Host group is a predefined group of machines. They could be servers, or other devices such 
as SAN or NAS. [A NAS would be represented as a Host Group.]

HOSTS
Hosts are servers or other storage points that appear as network machines in Windows. A Host 
appears in the console if a volume or path on the Host has been scanned and the scanned data 
entered into NSR’s database.

VOLUME
A volume is in most cases any logical drive or any storage point. However since scans of 
particular sub-folders on a logical drive is allowed, any kind of path can be entered as a volume, 
if so desired. 

Volumes are represented in the User Interface as a subset of their Hosts. You drill-down though 
the network, network group [Host groups], through the individual Hosts, through the volumes 
that logically reside on those Hosts.

USERS
The Users page shows usage by user account. You can drill down from usage on the network 
level, that is, total usage on all available hosts, to usage per Host Group or Host.

FILE TYPES
The File Types page presents general usage information for File Types. From this general page 
you can drill-down to specific information about a specific File Type. On the individual File 
Type’s pages you can for instance, see the amount of storage that a certain File Type has taken 
on a volume, or a host. You can also view File Type per User, or User per File Type ratios.

FILE TYPE GROUPS
The File Type Groups page presents a rough trend graph showing how this Group of file types 
has grown on your network. You also find a listing of all File Types that belong to this group. 
You can drill down by double-clicking any file type within the group. In the bottom right hand 
corner you can see how this File Type Group consumes storage per top-level Host Group.
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USER INTERFACE
Northern Storage Reporter consists of several different instant report pages. The main page is 
the Overview page, displaying aggregate data, regarding Hosts, volumes and usage. From the 
Overview page and the other principal pages you can easily navigate to see specific server, 
volume, User, or mailbox-related usage data. 

For quick viewing, volume-related data is displayed in lists. You can see lists of the largest files 
on a certain volume and get detailed information about the type of content the volume has. 

You can also navigate to information about a specific user. There is status information such as: 
total number of files belonging to the chosen user, or total size of used disk-space. You can also 
access information about the user’s Mailbox, if that functionality has been activated. 

In the Storage Reporter User Interface you are able to select items and right-click. [This will 
prompt a context menu to appear.] In every chart and table you will be offered to change the 
way the data is presented. For instance: if you are looking at a list of the most space consuming 
File Types on a given Volume you can right-click and choose “Pie chart” from the shortcut menu, 
and the list will change into a pie chart. You can repeat the procedure and choose Column chart 
and the Pie chart will change into a Column chart.

Each chart or table can be expanded so that you can enlarge the statistical representation and 
have a closer look at things.

[For a full flow chart showing the relationship between all pages see the fold out Site Map in 
Appendix 3.]

FRAMES AND CONTROLS
The User Interface is placed inside Internet Explorer. The focus is on different statistical data 
that are organized in different frames. These frames are ActiveX Controls and are therefore 
dynamic. That is, you can change the way the content of the frame looks. The borders and the 
top headings are based on HTML which make them static and unchangeable. 

You can double-click any item shown in the frame. This will open this item or as we call it “drill-
down” to that item. This means that you can double-click a Host Group to see the Hosts in that 
group and the double-click one of the Hosts to see its volumes, etc.

The frames have two buttons in their top-right corner. The first one is an expand button which 
allows the controls to be enlarged facilitating closer examination. The second button is an 
information button which briefly explain what is shown in the frame and how you can manipulate 
the data in it.
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In general you can, by right clicking the frame, affect at least one of the following changes to 
the data of any given frame:

View > Pie chart. Change the data shown into a pie chart.
View > Column chart. Change the data shown into a column chart.
View > List. Change the data shown into a list.
View > List. Change the data shown into icons.
Data > Count. Will sort items, or show items [e.g. files] according to their number.
Data > Size. Will sort, or show items according to their size.
Data > Average Size. Will show the average size of items [e.g. files].
Rounding. Will round down to the closest whole number.
Hide selected. Recalculates the statistics without showing the hidden data.
Hide non-selected. Hides all items that are not highlighted and recalculates the statistics.
Show all.

PIE CHART
Pie charts show the proportional size of items that make up a data series to the sum of the items. 
This kind of chart always shows only one data series, and is most useful when you want to 
emphasize a significant element, since you can highlight the different slices in the pie. This 
chart, as well as others, can be changed into either a Column chart, List or Line chart, by right-
clicking and choosing the desired form of representation from the shortcut menu.

Figure  1: A pie chart

[The pie chart is a good choice if you want to represent values, which have no zeroes [0], and 
no negatives.]
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COLUMN CHART
A column chart shows how data changes over a period of time, or in some case illustrates 
comparisons among items. Time units are organized horizontally, values vertically, this 
emphasizes variation over time.

Figure  2: A Column chart

LINE CHART
Line charts show trends in usage at equal intervals. The intervals are displayed as white vertical 
lines against a grey and orange background.

Figure  3: A Line char

OVERVIEW
The Overview page presents general usage information on Network level. Information you can 
find on this page include, for instance, the usage as a percent of total available storage. You 
can also find a graph showing the usage trend over time. You can click any Host group in the 
Host Groups list to drill down to the next level, showing a usage and content report for that 
group of servers. [The Administrator defines which hosts that should form a Group. For further 
details, See “Defining Host groups” on page 29.]
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Figure  4: Storage Reporter: Overview page

The Overview page contains the following frames:
Utilization
History
Host Groups
Monitored Hosts
Space Consumption by File Type Group
Space Consumption by User

HOSTS PAGE
On the Hosts page you find a summary of all Hosts, the list of Host Groups, a list of all Hosts, 
and a list of all scanned volumes in your network.
14 NORTHERN STORAGE REPORTER



Figure  5: Storage Reporter: Hosts
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HOST GROUP PAGE
The Host Group page displays usage information relevant to a set of Hosts, part of a predefined 
group of Hosts. In the left-hand pane you find a brief summary and from left to right you find 
panes displaying Utilization growth and Disk and I/O performance. The graph will become 
increasingly more valid as more and more scans are performed. Initially, when only one or two 
scans have been performed the graph does not, of course display information about the last 30 
days. If desired you can customize the number of days used in the graph.

The horizontal pane, Hosts in x, where “x” is the User-defined name of the Host Group, displays 
a list of all Hosts in that Group, or a list of lower-level Host groups [since Host groups can 
contain Host Groups]. In the bottom left-hand pane you find a list of the largest files in this Host 
Group, and the lists to the right display the oldest files in the Host Group, and a list with Space 
consumption by User.

Figure  6: Storage Reporter: Host Group page

INDIVIDUAL HOST PAGE
This page presents general usage information on machine or server level. Information you can 
find on this page is, for instance, usage as a percent of total available storage on a given server. 
You can also find a graph showing the usage trend over time. You can click any volume, File 
Type or User in the list to “drill down” to pages that give more details about that particular type 
of item.

In the left-hand pane you find a brief summary. From left to right you find panes displaying: 
Utilization growth, Disk and I/O performance, Utilization and a graph plotting the usage 
development over time. This last graph will become increasingly more valid as more and more 
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scans are performed. Initially, when only one or two scans have been performed the graph does 
not, of course display information about the last 30 days. If desired you can change the number 
of days included in the range, See “Getting current usage data” on page 40.

Figure  7:  Storage Reporter: Host page

INDIVIDUAL VOLUME PAGE
The Volume page displays information about a scanned network volume. Since Storage 
Reporter allows scans of both logical volumes and paths [that is sub-folders on any volume], 
you can have drives, as well as sub-folders [of any level] represented on this page. Apart from 
information about the level of Utilization on the Volume, you find a graph displaying the growth 
trend on the Volume the last 30 days. In the left hand corner you find lists displaying the top-
ten largest files, the top ten oldest files, a list of the most space-consuming users, and a list of 
the most space-consuming File Types. 

Figure  8: Volume page
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Disk and I/O Performance
This frame displays a collection of performance counters. 

Disk queue length
Number of requests outstanding on the disk at the time the performance data is collected. It 
includes requests in service at the time of the snapshot. The value represents an instantaneous 
length, not an average over a time interval. Multi-spindle disk devices can have multiple requests 
active at one time, but other concurrent requests await service. This property may reflect a 
transitory high or low queue length. If the disk drive has a sustained load, the value will be 
consistently high. Requests experience delays proportional to the length of the queue minus the 
number of spindles on the disks. This difference should average less than 2 for good 
performance. 

Time spent writing to disk
Percentage of elapsed time that the selected disk drive is busy servicing read requests. 

Time spent reading from disk
Percentage of elapsed time that the selected disk drive is busy servicing write requests. 

Disk cache misses
Frequency of cache misses caused by lack of available resources to satisfy the request. 

RAM cache faults
Number of faults which occur when a page sought in the file system cache is not found there 
and must be retrieved from elsewhere in memory (a soft fault) or from disk (a hard fault). The file 
system cache is an area of physical memory that stores recently used pages of data for 
applications. Cache activity is a reliable indicator of most application I/O operations. This 
property counts the number of faults without regard for the number of pages faulted in each 
operation. 

Available RAM
Amount of physical memory in bytes available to processes running on the computer. This value 
is calculated by summing space on the Zeroed, Free, and Stand-by memory lists. Free memory 
is ready for use; Zeroed memory is pages of memory filled with zeros to prevent later processes 
from seeing data used by a previous process. Stand-by memory is memory removed from a 
process's working set (its physical memory) on route to disk, but is still available to be recalled. 
This property displays the last observed value only; it is not an average.
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USERS PAGE
This page presents general usage information for all Users. Information you can find on this 
page is, for instance, the total amount of storage that a given User has taken on your hosts. You 
can also find the usage percent per User, showing the amount that each User uses relative to 
the other Users.

Figure  9: Storage Reporter: Users page

INDIVIDUAL USER PAGE
The Individual User page displays usage data for a specific user on your network. You are given 
information about where the User stores his data, and how much he or she uses on each Host 
or Host Group.

Figure  10: Individual User page
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FILE TYPES PAGE
This page presents general usage information for File Type Groups. Information you can find on 
this page is, for instance, the total amount of storage space that a certain File Type Group has 
taken. You can also find the usage per individual File Type.

Figure  11: Storage Reporter: File Types page

INDIVIDUAL FILE TYPE PAGE
This page presents general usage information for a certain File Type. Information you can find 
on this page is, for instance, the total amount of storage space that a certain File Type has taken.

FILE TYPE GROUP PAGE
This page presents general usage information for a user-defined File Type Group. Information 
you can find on this page is, for instance, the total amount of storage space that files of certain 
formats consume.

REPORTS PAGE
This page presents you with a set of customizable reports. The reports give invaluable 
information about a range of storage-related issues. You click the Define button to define a 
report. All reports are defined using Wizards. You can check on and compare with old reports 
by clicking the Results button. The Report Result page shows a list of all reports that have been 
defined and run.
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Figure  12: Northern Storage Reporter: Reports page
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CONFIGURE
CONFIGURING NORTHERN STORAGE REPORTER
To be able to benefit from the reports provided by Storage Reporter you have to install the 
software, create an MS SQL database [or assign Storage Reporter a database that already 
exists].

When a database has been provided you must schedule Storage Reporter to scan your 
network servers. Only the servers that are scanned will be analyzed and available in the various 
reports in the Storage Reporter Client.

Make sure to scan all public storage points and all available drives on each point. The analysis 
of the whole network relies on the scope of the data available to Storage Reporter. If only 50% 
of all drives are scanned and used in the storage analyses you might find out that the total 
network storage will be near-full in half the time it will actually take to fill it.

It is also recommended to scan all drives at roughly the same time, this will ensure that 
discrepancies due to time is kept to a minimum. 

OVERVIEW
To configure Northern Storage Reporter properly you must make sure to take all of the following 
steps:

Create an Microsoft SQL server database, See “Creating a new database in MS SQL” on 
page 25.
Optional: define a SQL User account for Storage Reporter, See “Creating an account for 
Storage Reporter” on page 26.
Connect Northern Storage Reporter to the SQL server database, See “Adding an SQL 
Database connection” on page 27.
Add Hosts, See “Scheduling a scan” on page 30
Define Host Groups [optional], See “Configuring Host Groups” on page 29
Define File Type Groups [optional], See “Adding a File Type Group” on page 34.

ABOUT MSDE
NSR comes with MSDE [Microsoft Database Engine]. This is a limited version of Microsoft 
SQL. It limited to 5 [five] database connections and the database is limited in size to 2 GB. 
[Each control in the NSR client will use one such connection. As a consequence, there will be 
a significant performance impact when loading the data to the client].

MSDE is installed automatically. If you do an installation with an Evaluation license. You can 
choose not to install MSDE by choosing Custom installation and clearing [unchecking] the 
MSDE install option.

It should also be kept in mind that the MSDE is by no means an ideal database. It has the 
aforementioned limitations and furthermore is limited with respect to through-put and overall 
performance.
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The MSDE should by no means be installed on a computer running MS SQL server since the 
MSDE is a small version of MS SQL it will conflict with it [i.e. they have the same name and 
installing MSDE on top of an MS SQL installation will corrupt it].

ABOUT THE DEMO DATABASE
NSS ships with a Demo database for NSR. This Demo database contains fictional data, 
showing prospective customers and evaluators what a full implementation of NSR would look 
like.

Note the following:
The database is static and inert. It contains fictional data.
You cannot run a scan on any of the Hosts shown. They do not exist.
The reports cannot be run.

SCANNING DATA TO THE DEMO DATABASE
To export scan data to the demo database:

1 Make sure that the Demo database is selected in the Database Connections control.

2 Add a REAL host, in the Host Management control.

3 Proceed to run any desired reports or scan on the real Host.

DELETING THE DEMO DATABASE
To permanently remove the Demo database:

1 Run the SQL Enterprise Manager.

2 if applicable, Add the server which has the Demo database installed.

3 Browse to the NSS demo database, right-click and select Delete from the shortcut menu.

Figure  13: SQL Enterprise Manager
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4 Verify your decision by clicking OK.

Notice if you’ve installed the Demo databases on MSDE, you can always remove the demo 
database by uninstalling MSDE.

CONFIGURING MS SQL SERVER
Since Northern Storage Reporter performs scans of your storage and places usage information 
in a Microsoft SQL Server database, you have to prepare a database for Storage Reporter to 
use. You can also do this configuration in the installer.

CREATING A NEW DATABASE IN MS SQL
To create a new MS SQL database:

1 Choose: Start > Programs > Microsoft SQL Server > Enterprise Manager.

Figure  14:  Starting Microsoft SQL

2 In the MS SQL Manager, expand your desired SQL server and right-click the Databases 
directory and select “New database...” from the shortcut menu. The Database Properties 
dialog appears.
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Figure  15: Creating a new database in MS SQL

3 Give the new database a name, e.g. “SRMNEW”, and click OK.

Figure  16: Database Properties dialog box

4 Give the account “SRMNEW” permissions to the database

CREATING AN ACCOUNT FOR STORAGE REPORTER
Northern Storage Reporter places the storage data it collects in an SQL database. This data is 
the basis for all reports and storage analyses. For this reason Northern Storage Reporter needs 
to have read and write access to its database.

To create an SQL account for the Storage Reporter:

1 Right-click the Users object in the database you created above, and choose “New 
database User...” from the shortcut menu. The New Login dialog appears.
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Figure  17: Creating a new database User

2 In the New Login dialog, on the Database Access tab, make sure that the Storage 
Reporter’s scanner is given the database role “db_owner”.

Figure  18: SQL Server Login Properties - New Login dialog box appears

3 Click OK.

CONFIGURING DATABASES
When you have created a database and given Storage Reporter access rights you should 
proceed to input information about which database Storage Reporter should use on the 
Configuration page.

ADDING AN SQL DATABASE CONNECTION
To create a database connection in Storage Reporter:

1 On the Config page click the Database Connections link. The Database Connections 
control opens
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Notice!  If you want to 
add more database to 
be able to use several 

database servers, repeat the 
procedure as described. A 
second, third, fourth, etc. 
database connection will be 
added to the Database 
Connections List.
2 Click the Add button. The Add Database Wizard appears. 

Figure  19: Add Database Wizard

3 Follow the on-screen instructions.

The ’Master Server’ is an NSR server which retains information about other licensed NSR 
servers. The Master Server also retains information about which Mail Server to use, which Mail 
Account and how old data to show in Storage Reporter..

SWITCHING TO ANOTHER DATABASE CONNECTION
To switch to another database:

Choose which database server to use by selecting the Active option of the desired server. 
This indicates to Northern Storage Reporter that this is the database to retrieve data from.

MODIFYING A DATABASE CONNECTION
To modify a database connection:

1 Select the connection you wish to modify in the 'Database Connections' list. 

2 Click the Edit button to launch the Database Connections Wizard.

3 Go through the wizard and change any parameter you desire. 

DELETING A DATABASE CONNECTION
To delete a database connection:

1 Select the entry you wish to delete in the 'Database Connections' list.

2 Click the Remove button to remove the connection string from Northern Storage Reporter. 

NOTICE: The delete operation as described above will not delete the database itself, nor its 
contents. It will merely remove the connection. For instructions on how to destroy database 
content, See “Deleting obsolete database entries” on page 34 
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CONFIGURING HOST GROUPS
Host Groups is essentially a folder item. Different Hosts, that is SAN, NAS devices and servers 
are organized in various Host Groups. You define the name and content of Host Groups 
yourself. For instance you might have Host Groups that correspond to geographical location 
like the New York City group and the Los Angeles Group. Or, you might have groups based on 
departmental divisions: the Marketing Host Group or the Finance Host Group.

DEFINING HOST GROUPS
To add a Host Group:

1 On the Config page in the Host Group Management section, click the Add Group button. 
The Add Group dialog box appears.

2 Enter the name of the new Host Group. 

3 Click OK.

REORGANIZING HOST GROUPS
You can drag and drop and move host within groups as you desire.

CONFIGURING HOSTS
The term 'Host' is used in NSS to designate any data storage unit [such as a computer or SAN] 
that can be monitored by NSS. The NSS service must be installed on every Host that you wish 
to monitor by NSS.
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SCHEDULING A SCAN
To add and scan a Host: 

1 On the Config page, click the Hosts Management link. The Host Management Control 
opens 

Figure  20: Host Management Controll

2 In the Hosts control, click the Add button. The Host Wizard appears. 

Figure  21: Add Host Wizard
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Notice!  The Path 
browser display a 
view of the file system 

as seen from the NSS service 
account. The NSS Core 
Service on the target Host 
must be running to be able to 
browse the network or the local 
paths. .
3 In the 'Server' field, enter the name of the Host you wish to monitor. Click Next.

Figure  22: Server identification page

4 On the additionnal configuration page, make sure to check "Storage Reporter", then click 
Next.

Figure  23: Product selection page

5 Click the Add button to include a Volume. The Path Browser dialog appears.

The Browser dialog includes two tabs, one for all path local to the NSS service, one for other 
network paths. Storage Reporter can scan any number of local and remote paths. A remote 
scan from a NSS server A to a machine B does not require any installation on machine B. As a 
matter of fact, machine B does not need to run any Windows version providing it support 
CONFIGURE 31



Notice!  If you set 
scans for repeated 
intervals the scan will 

be run at the time you’ve 
indicated for the first scan. For 
instance, if you’ve set a scan 
for the 4th of July at 3 p.m., and 
the interval every three weeks, 
the scan will be performed the 
third week after the 4th of July 
at 3 p.m.
Microsoft CIFS. This way one can instruct Storage Report to scan any kind of CIFS-compliant 
NAS devices.
Figure  24: Path Browser dialog

6 On the Schedule page, specify how often the scan should be performed. Choose to 
either:

Run the Scan Once [Choose Perform Now and the interval “Never”]
Run the Scan at regular intervals, for instance every 3 weeks
Run the Scan at a specific time, for instance 2002-12-20 at 12.00 hours. 

Ensure that the scans are performed at practical intervals. Click Next.
Figure  25: The Schedule Page
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7 Select database where the data should be stored. Only the database define in the 
Database Configuration control will be available here. Click Next.

Figure  26: The Database Selection page

8 Check the summary on the Finish page and click Finish.

Figure  27: The Summary Page

DELETING A HOST VS. DISABLING A SCAN
It is important to understand the implications of disabling a Host from the list. When you disable 
a Host, it will NOT remove any data from the database, NOR will it uninstall the NSS service 
from that machine. It will however remove any future scans that you have defined for that Host. 
This means that data will be filtered out of view in the web interface, as it becomes obsolete ]. 
To truly delete all data for a certain server from the database you have to open the Database 
Management control and delete the database entries.

DISABLING A SCAN
Disabling a scan will NOT remove anything, neither data from the database, nor any scan 
definition. Furthermore, it won't uninstall the NSS service. Disabling a scan, will simply stop the 
scan from running until you enable it again.
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CONFIGURING FILE TYPE GROUPS
For easy viewing, the content of your storage can be grouped in terms of broader file type 
categories. This makes for easier monitoring. Instead of a jumble of jpgs, gifs and etc. you can 
bring them together under the heading “Media Files”.

You can add your own File Type Groups or edit the reach of each File Type Group.

ADDING A FILE TYPE GROUP
To add a File Type Group:

1 On the Config page in the File Types control, click the Add Group button. The File Type 
Group Definition dialog box appears.

2 Enter the name of the new File Type Group. 

3 Click OK.

MODIFYING A FILE TYPE GROUP

1 On the Config page in the File Types control, highlight the desired Group and click the 
Add Type button. The File Type Definition dialog box appears.

2 Enter the extension of the new File Type. [Do not include the dot.] 

3 Click OK. 

ABOUT SCANNING
Storage Reporter performs scans of volumes residing on a server. Through an advanced 
algorithm it browses the content of a volume very quickly. It exports the data it has collected to 
a database. The export to database, as such, creates a network overhead and should therefore 
be scheduled for times when network traffic is not affected.

DELETING OBSOLETE DATABASE ENTRIES
Storage Reporter stores its statistical data in an MS SQL server database, it compiles these 
statistics and presents the results in different pages and frames. However, the data Storage 
Reporter puts to the database will slowly grow obsolete. Depending on the needs in your 
organization you might decide to delete data from the database at, for instance, a monthly or 
yearly basis, saving only the most recent storage statistics.

If your database is growing too large or if it ends up containing very old data, it can be desirable 
to delete database entries. Apart from deleting entries because they’ve become old you may 
desire to delete all entries of a certain host, since the host has been replaced, or delete all 
entries on a certain user, because he has quit, etc.

To delete database entries:
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Notice!  THIS 
MEASURE WILL 
PERMANENTLY 

REMOVE THE ENTRIES 
FROM THE DATABASE
1 On the Config page in the Database Management control, select ‘Time’ from the ‘Show 
database usage by” drop-down list.

Figure  28: Config page: Database Management: Deleting databases 

2 Select the dates that you want to delete and click the Delete button.
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USAGE
DRILLING DOWN - THE TOP-DOWN APPROACH
Storage Reporter has been built to deal with enterprise-size environment. To facilitate viewing 
storage statistics for large environments you, at first, need to see storage on the top level, 
getting general network-wide consumption statistics, for instance checking on total available 
storage.

To get more specific usage data you can drill-down to an intermediate level where usage 
statistics per Host, per File Type group or per User becomes available. If you drill even further 
you can check on the distribution of certain File Types, or on how much and what a certain user 
stores. 

The drill-down approach will allow you to peal off the layers of your network, in the end reaching 
individual volumes, Users or File Types.

Figure  29: Drilling down to get more specific data.

Macro level - network-wide storage usage and trends.
Intermediate level - usage statistics per Host, or per File Type group
Micro level - the individual User’s, File Type’s or volume’s usage and trends.

ANALYSING STORAGE USAGE
Northern Storage Reporter makes it possible for you to know in a quick and certain way, where 
what is stored and how much you’ve got stored, how much new material you stored yesterday, 
and much more.
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There are principally three important perspectives on Storage Usage Analysis:

Monitoring and safe-guarding the performance of your hardware resources.
Monitoring and keeping track of the people in your organization: checking on Users and 
their storage use.
Monitoring and managing the content of your Hosts: are your Hosts filling up with old 
files? Private or recreational files?

These three broad monitoring practices correspond to three perspectives on Storage 
Reporting:

Hardware-oriented viewing
Organization-oriented viewing
Content-oriented viewing

Figure  30: Three perspectives on Storage Reporting

HARDWARE-ORIENTED VIEWING
To keep track of the status of Hosts is of course very important. The Overview gives you 
information about the status of your machines. The Host Group icon signals if the Hosts are 
near full, you get instant information on how many hosts that are full or near full. You can drill 
down to Host level and volumes to check on the status of your devices. Usage is give in percent 
as well in intuitive partially filled cylinders: you can immediately see if a volume is full, near full, 
or has ample space.

To navigate to a specific Volume to check on its overall status:

1 On the Overview page double-click the Host on which the logical Volume resides. The 
desired Host page is displayed.
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2 Do one of the following:

Check the overall usage of the desired Volume by checking how much of the volume is 
filled.
On the Host page, double-click the desired Volume to check on its content.
Check on the performance of the desired Volume by conferring disk and I/O performance 
with desired performance values.

ORGANIZATION-ORIENTED VIEWING
To keep track of the people in your organization, checking on the usage development of Users, 
you can browse to the Users page or individual User pages. This makes it easy for you to make 
comparisons between various groups to get a clear picture of who’s using the most resources.

To navigate to specific User to check on his or her usage:

1 On the Overview page click the Users button. The Users page is displayed.

2 Do one of the following:

In the Usage per User frame, sort on most consuming or least consuming User and 
compare.
Get an overall impression of the Users’ usage by inspecting the Usage [%] per User [the 
pie chart to the right].
Double-click a User in the list, that User’s page appears. Proceed to inspect that User’s 
usage on the relevant Hosts in the Usage per Host frame.

Figure  31:  User page: Usage per Host frame

CONTENT-ORIENTED VIEWING
To know the content of your Hosts is important if you want to save money and house keep with 
hardware resources. You can browse to the File Types page to get a general picture of what 
kind of content you have. Then you can proceed to drill down to a specific File Type page, for 
instance to the MP3 page to have a look on how much that file type is using across the network. 

To navigate to a specific File Type to check on its total usage:

1 On the Overview page click the File Types button. The File Types page is displayed
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2 Do one of the following:

In the Usage per File Type frame, sort on most consuming or least consuming File Type 
and compare.
Get an overall impression of the File Type’s usage by inspecting the Usage [%] per File 
Type [the pie chart to the right].

Figure  32: File Types page: Usage [%] per File Type frame

Double-click a File Type in the list, that File Type’s page appears. Proceed to inspect that 
File Type’s usage on the relevant Hosts in the Usage per Host frame.

SHIFTING PERSPECTIVE ON USAGE DATA
Most of the usage data displayed in Northern Storage Reporter can be re-calculated and 
resorted ad-hoc in the frame where it is shown.

The shortcut menu that becomes available on a right-click offers several options that give you 
opportunity to shift perspective on the data in front of you.

GETTING CURRENT USAGE DATA
Since Northern Storage Reporter enables you to make scheduled scans of any number of 
drives you easily end up with different scans at different points in time. Perhaps you scan all 
drives on server Alpha every two weeks, and you scan Server Beta once every month, and 
perhaps you scanned server Gamma once in January and haven’t scanned it since. If you then 
generate a general report on all three servers, you could get usage data of very dissimilar age. 
The data from Alpha is fairly current, but the data from Beta is a month old and the usage data 
from Gamma is actually from the beginning of the year.

In order to off-set possible dissimilarities you can configure the time-span within which scans 
are considered current. The default is 30 days, any scan older than 30 days will not be used in 
the reports. 

Another point to consider, when it comes to scan intervals, is the fact that the Storage 
Reporter’s data can become ostensibly obsolete if you make major changes in file placement 
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or if you delete a lot of files. For instance, you notice that Server Alpha’s D drive is filled to the 
brim with MP3s: you delete them. Then you return to Storage Reporter to have a look at how 
things are in your network, and you discover that the MP3s are still there - when in fact they are 
not. The Storage Reporter will not, of course, notice this change until it has re-scanned the 
volume.

To get current usage data:

1 On the Config page in the Display section, in the Number of days before last scan is 
considered obsolete field, enter the desired time-span.

2 Click Save.

ABOUT REPORTS
The Reports are different from the instant scans available from the pages of Storage Reporter, 
in so far as they can be given more customizable definitions. The Reports as such have been 
supplied to facilitate analysis of more specific storage patterns.

SCANNING REPORTS
Reports that fetch their data from the file system information are called Scanning Reports. The 
file system scan is made accordingly to the Report scheduling. The data is processed by the 
reporting engine according to the Report parameters and stored in the SQL database.

The Scanning Reports are:
Report On Size
Report On Creation Date
Report On File Extension
Report On File Binary Format
Report On Archive attribute
Report On Non-Standard Streams
Report On Modification Date
Report On Last Access Time
Report on Duplicate Files
Files owned by User
Files owned by obsolete user accounts

The scan is performed within the context of the NSS Core Service account but using Backup 
privileges. This implies that the scan will be able to access directories and files that are not 
normally accessible for the NSS Core Service account.

DATABASE REPORTS
This kind of Reports retrieves and process information from the SQL database. As such, they 
rely on the data of previously run scans [as defined in the Host Management Control of the 
Config Page].
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The Database Reports are:
Report On File Type Growth
Report On File Types Above a Certain Threshold
Host Near-full
Host Growth
Path Near-full
Path Growth
Top X space-consuming users
Top X growing users
Host Near-full projection
Path Near-full projection

Database reports will require at least one previous scan. The projections [Host Near-full and 
Path Near-full] require at least two previous scans to be able to perform a correct extrapolation.

GENERATING A REPORT
All Reports are created through their dedicated wizard. Most of the pages of that wizard are 
common to all Report type. However, each Report will have its own Properties Page where the 
actual Report settings are set [for example, the threshold size of a Report On File Size]. Also 
Scanning Report will propose a page to choose which path or paths to scan. Database Report 
will retrieve the data from the current database, as selected in the Database Connection 
Control of the Config Page.

To generate a Report: 

1 Go to the Report main page

Figure  33: The Report page
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2 Choose the desired Report type by clicking the "Define" button. The Schedule Report 
page appears. 

The list on the page will display all defined Report of the choose type for all the NSS Hosts.
Figure  34: Schedule Report page for a given Report type

3 Click the "Add..." button at the bottom of the page. The Schedule Report Wizard appears.

Figure  35: The Welcome page of the Schedule Report Wizard

4 Clicking Next from the Welcome page will bring to two different pages depending if you 
are creating a Scanning Report or a Database Report

For Scanning Report continue reading at point 5, the Scope Page
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Notice!  .A path to be 
scanned by a Remote 
Report must be 

compliant with Microsoft CIFS 
1.0

Notice!  .You can 
check the connection 
status of all Hosts by 

clicking the "Show Details..." 
button on the Report Schedule 
Page.
For Database Report jump to point 8, the Parameters Page

5 On the Scope Page you select which type of Scanning Report to perform

Storage Reporter supports Local Reports which scan only data local to the NSS Server or 
Remote Reports which can scan data from other Host than the NSS Server. A Remote Report 
is specifically designed to scan data from non-Windows host like NAS boxes since no software 
is required to run on the remote host to be scanned. Remote Reports will collect data over the 
network so they performance is somewhat lower than local Reports. Except for the Binary Type 
and the Duplicate File reports, the file data is not actually transferred over the network. The 
network usage is limited to accessing the much smaller file information [ownership, size, 
permissions, ...].

Custom reports are mixed Reports and can scan both local and remote paths.

Figure  36: The Scope page of the Schedule Report Wizard

6 On the Host Selection Page, you choose which Host will execute the Report.

Reports use two kinds of Hosts: one Managing Host and one or more Data Hosts [The 
Managing Host can also be a Data Host]. 

The Managing Host is the Host that will actually perform the scan and process the retrieved 
information to store it into the database. As a consequence, if the NSS Core Service is not 
running on the Managing Host, then the Report will not be executed. It’s also the context of the 
account of the NSS Core Service on the Managing Host that will determine which path and 
files will be accessible. A Managing Host can only be one the Host added in the Host 
Management Control of the Config Page and that can be connected to successfully.

The Data Hosts are Host where the data to scan resides. No software needs to be running on 
those Hosts. A Data Host merely needs to be compliant with CIFS 1.0. A Data Host does not 
need to be added in the Host Management Control of the Config Page.
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The Host Selection Page looks different depending if the Report is Local, Remote or Custom.
Figure  37: Host Selection Page for Local Report

For a Local Report, the Host to select is both the Managing and the only possible Data Host.

Figure  38: Host Selection Page for a Remote Report

For a Remote Report, you are asked to the select the Managing Host.
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Figure  39: Host Selection Page for a Custom Report

For a Custom Report, the page allows you to choose the Managing Host and add all Paths this 
Host must scan. The path can be either remote or local. Refer to the next point 7, the Path Page, 
for a description of how to add Path to a Custom Report.

7 After clicking Next on the Host Page you reach the Path Page.

This page is only accessible for Local and Remote Reports. Custom Reports have the Path 
Page and the Host Page merge into a single page.

The page looks different for Local and Remote Report.

Figure  40: The Path Page for a Local Report

Click the "Add..." button to add paths to be scanned. This will bring the Path Browser for Local 
path.
46 NORTHERN STORAGE REPORTER



Figure  41: Path Browser for Local path

For a Remote Report the Path Page looks like below.
Figure  42: The Path Page for a Remote Report

Clicking the "Add..." button will bring the Path Browser for Remote Path.
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Figure  43: Path Browser for Remote Path

The browser will allow you to select any path on the network accessible from the NSS Core 
Service of the Managing Host. All paths are handled as network path. This implies that a 
Remote Report can only scans public shares on the Managing Host [and not the local paths]. 
If you want to scan both network path and local path of the Managing Host, you need to use 
the Custom Report.

Clicking Next on the Path Page will move the wizard forward to the report Parameters Page.
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Notice!  .Setting the 
repetition interval to 
"Never" will 

effectively disable the scan IF 
you want a Report to run only 
once, select "Perform Now" 
and "Repeat Never"..
8 The Parameter Page is different for each Report types, it will be the threshold size for a 
Report on File Size or the account name for a Report on Obsolete Files, etc.... Click Next.

Figure  44: The Parameter Page for a Report on File Size

9 On the Schedule Page you define when the Report should be executed.

A Report can be executed once or repeated at fixed interval. You can also select when is the 
first run of the report, either immediately or at a fixed time. If you select "Perform Now", the 
Report will be executed as soon as it is added to the Host.

Make sure that the repetition time leaves enough time for the Report to finish. The scheduling 
engine in Storage Reporter will make sure that two instance of the same Reports cannot be 
executed at the same time [to avoid I/O collapse].

Figure  45: The Schedule Page
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Notice!  Under 
Windows 2003, the 
messenger service is 

disabled by default. This means 
that Popup notifications will fail 
if the NSS service or the 
recipient are using a Windows 
2003 machine. The messenger 
service needs to be enabled 
manually through the Services 
Administrative Tool.
Click Next.

10 On the Notification Page you specify if you want to be notified of a completed report, 
either by popup or e-mail, and provide the appropriate details.

You can receive either one or both a popup and email notification. Popup can be send to either 
a user name or a computer name. Mail notification can be sent to any valid email address 
reachable from the selected SMTP server. Make sure that you enter a valid user name or email 
address in the "From" field.

Figure  46: The Notification Page
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Notice!  The name 
cannot be changed 
after creation of the 

Report..
11 On the Identification page, you enter the Report Name and Description

Only the Name is mandatory and must be unique across on the Managing Host. The 
Description is used as memo information and does not need to be entered [or it can be entered 
when the Report is edited].

Figure  47: Identification Page

12 You have reached the Finish page. Clicking the Finish button will effectively add the 
Report to the Managing Host.

SAVING REPORTS AS CSV FILES
Any report run from the Reports page can be exported to CSV format. 

To export a Report to a CSV file:

1 On the Reports page, click the Results link of the report type you wish to export. The 
Results page appears.
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The Result Page displays one entry for each run of each Report of the choosed type. 
Figure  48: The Report Resutls page for Report On File Size

2 Right-click the Report entry you wish to export and Choose Save as CSV file from the 
shortcut menu. The standard Save as dialog appears.

3 Give the CSV file a name and save it to the desired location. 

EXPORTING REPORTS AS MS EXCEL FILES
Any Report run from the Reports page can be exported to the MS Excel templates. MS Excel 
must be installed on your client machine for this functionality to work.

Storage Reporter supports to kind of Export to MS Excel, either a simple output of the data into 
an empty Excel spreadsheet or a template based export. The template files, in XLS format, 
include formulas and formatting to display the Report result under various views. The template 
files are customizable and new templates can be created to accomodate more advanced layout.

To export a Report to an empty MS Excel spreadsheet follow the instruction above in “Saving 
Reports as CSV files” on page 51. Make sure you choose the menu item "Export to Microsoft 
Excel" instead of "Save as CSV File...".

To export a Report to a MS Excel template:
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1 On the Reports page, click the Results link of the report type you wish to export. The 
Results page appears.

The Result Page displays one entry for each run of each Report of the choosed type. 

2 Select the Report entry you wish to export by clicking it in the list

3 Select which Excel template to use in the dropdown at the bottom of the frame

The dropdown will include one or more template. Storage Reporter comes with one default 
template for each Report type. Additionnal templates will also be displayed in this list when 
added according to the section “Managing MS Excel Templates” on page 54.

Figure  49: The Export to Excel frame

The Export to Excel frame displays all available templates for the current Report type. It also 
provide you a quick link to the template location by clicking the "Manage Templates" button. 
This will open a File Explorer to the path specified in the frame. From there you can add new 
template or modify existing one as described in “Managing MS Excel Templates” on page 54.-
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4 Click the "Export" button. MS Excel wil be opened, and the Report result imported, using 
the selected template.

Note that depending on the size of the data, the export might take several minutes. Also, MS 
Excel will not be handle Report will more than 16000 results.

5 Save or Print the Report from MS Excel.

MANAGING MS EXCEL TEMPLATES
Storager Report comes with one default template for each Report type but it supports any 
number of custom templates. Creating a new basic template is just a matter of dropping an 
Excel file into the proper directory.

Directory Structure
The Excel templates are all located on the Master Server under the NSS installation directory. 
The screenshot below shows the template directory structure

Figure  50: NSS Excel template directory structure

All files are located in a subdirectory called Template. Then the templates are categorized by 
NSS modules [Northern Storage Reporter and Northern Storage Chargeback supports export 
to Excel], output format [for now only Excel format is supported] and langage. Langage support 
is reserved for future use.

Finaly, there is one sub-directory per Report type. The directory name always start with an 
internal code for the Report type and then the name of the Report type. The name is irrelevant 
for Northern Storage Suite, so that it could be localized. However, the internal code is 
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mandatory and must always be at the start of the name. If the code is changed or removed, NSS 
will not be able to find the templates for that Report type.

All the Excel files in the Report type directory will be presented in the Export to Excel dropdown.
Figure  51: The Export to Excel frame

So to add a new template one just need to copy a new MS Excel file in the proper Report Type 
directory. To learn how to customize the layout of the template, refer to the next section.

Template File Format
The templates are regular MS Excel worksheet. The worksheet could be empty or contains 
templates tags and comments. A template tag is an instruction to Northern Storage Suite on 
how the data must be filled in the template. A template comment is anything else in the 
worksheet, formulas, bitmaps, text, .... Template comments are simply ignored and untouched 
by NSS.

All template tags are defined as MS Excel Names. Storage Reporter recognizes the following 
tags.
Figure  52: MS Excel Template Tags

TAG DESCRIPTION

DataStart Northern Storage Suite needs to know where the exported data should be 

placed. This is defined by the range of the DataStart name. NSS will fill in one 

value for each Excel cell beyond the start of the range. The name can point any-

where on any sheet, but note that all cells below can be overwritten by the 

export, depending on the length of the data set.

NSS_Data_RepeatX Where X is a number 1 or more. These names define ranges of cells that will be 

filled down as per the standard Excel menu item. These names can be used to 

extend formula ranges to match the length of the data set as exported by North-

ern Storage Suite. 

NSS_Data_Attr_Name If present, the cell referenced by this Excel Name will be filled with the name of 

the report as defined in the Report Definition Wizard.

NSS_Data_Attr_Server If present, the cell referenced by this Excel Name will be filled with the name of 

the host that has generated the report.

NSS_Data_Attr_Runtime If present, the cell referenced by this Excel Name will be filled with the date and 

time when the Report was executed [this refer to the Report scanning time, not 

the exporting time].

NSS_Data_Attr_ID If present, the cell referenced by this Excel Name will be filled with the internal ID 

of the report.
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Northern Storage Suite will also define MS Excel Names after the export is performed to 
describe the position and shape of the data. Those Names can then be used in your formulas.
Figure  53: Predefined MS Excel Names for Templates

NAME DESCRIPTION

NSS_Data_Col_x The complete range of cells in the X'th column of the raw exported data set.

NSS_Data_Table The range of cell containing all the data of the report.
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TECHNICAL
ADVANCED ISSUES

SECURITY 
To protect the Northern Storage Suite in general and Storage Reporter in particular the Storage 
Suite share should be protected so as to allow administrator access only.

CACHING
Northern Storage Reporter client loads its ActiveX controls with usage data from an MS SQL 
server. The ActiveX controls themselves will normally try to load data from the SQL server each 
time you go to a certain view in the Northern Storage Reporter client. To increase performance 
speed the client caches the usage data it displays. This means that the client doesn’t have to 
reload a page each time you want to view it, something that would slow down navigation in the 
client. The cache keeps statistical data in memory for 24 hours from the first time you loaded it. 
After 24 hours the cache releases its data and will attempt to load fresh data from the SQL 
server the next time you open the client. An exception to this is if there is no data in the 
database. If this is the case, the cache will refesh itself as soon as there is data in the database.

It is worth to notice that the caching in the client can result in some potentially undesired side-
effects. For instance: You load the Overview page in the morning and during lunch a scan is 
performed. When you open the client the next time it will still show the data it showed in the 
morning. The new statistical data will not be available until the next day.

You can force the client to refresh the cache by killing the NSS_Cch.exe (using the Task 
Manager). This has no negative side effects whatsoever and can be done whenever you feel 
like it. The cache will immediately restart each time you load the client so you can still benefit 
from increased navigation speeds after having terminated the cache.

If you for some reason want to disable the caching completely, you have to rename the 
NSS_Cch.exe This will ensure that the cache won’t be started again. The executable can be 
found in C:\WINNT\system32.
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NORTHERN
NORTHERN: THE COMPANY
Northern Parklife, Inc. [NORTHERN] develops storage management software for Microsoft 
Windows server environments. Working with a global network of resellers and authorized 
distributors, the company’s products are sold in 52 countries worldwide. NORTHERN® 
supplies a global market through its two offices, Tampa [Florida, US] and Stockholm [Sweden].

Northern is distinguished by the flexibility and reliability of its family of storage management 
solutions, as well as its unmatched customer support and responsiveness to market demand.

BUSINESS CONCEPT
NORTHERN develops and simplifies storage administration in Microsoft Windows server 
environments with advanced software technologies. Our products and employees help 
systems administrators to succeed in rationalizing and gaining better control over their IT 
resources.

Business Mission
NORTHERN’s business mission is to provide system administrators with more Time to 
Manage Storage. The design core of all NORTHERN solutions is the capacity to re-balance 
the equation of increased responsibilities and static or diminishing resources. System 
administrators are saddled with an increasing range of responsibilities while their resources, 
particularly their time, remain limited. NORTHERN delivers a range of inherently tactical, while 
at the same time easy-to-use storage management tools that serve to augment the IT 
organization by reducing workload and increasing efficiencies. Our software makes storage 
administration simpler and less prone to error, and gives administrators greater latitude in 
developing and implementing creative business solutions that enhance their value to the 
organization.

NORTHERN software offers system administrators:
More time for pro-active planning and creative problem-solving
Better oversight and control
Easy, hassle-free installations
Simple, friction-free administration
Reliability
Fewer end-user issues (lightening the support burden)
More spare time and free weekends

Time to Manage Storage is the removal of unnecessary repetition and complicated word-
arounds, providing time for pro-active Storage Resource Management and time for job 
fulfilment.

THE MARKET
NORTHERN is the leader in the European systems administration software solutions market, 
which is comprised of systems administrators and network managers tasked with managing a 
broad range of network responsibilities. Because networking issues know no geographical 
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boundaries, the European and US markets served by NORTHERN allow for a consistent global 
marketing and product development strategy.

PRODUCT DEVELOPMENT
NORTHERN’s product development is managed internally and driven by feedback from 
customers, Windows NT/2000 users and discussions with NORTHERN’s board of advisors 
that consists of financial, technical and market experts.

CUSTOMER SUPPORT PROGRAM
Take advantage of expert technical guidance and inexpensive upgrades with NORTHERN’s 
Customer Support Program

You have invested in a CD-ROM from NORTHERN, a software product. Every effort has been 
made to ensure that this software is your solution. But sometimes something extra is needed, 
to guarantee your investment.

The need for continuous organizational advances, network configurations, hardware 
peculiarities; these factors can lead to time consuming issues and the need for constant system 
evolution. This is when the NORTHERN Customer Support Program becomes invaluable: 
uncomplicated and inexpensive upgrading of your system to the most advanced solutions 
available, and smooth installation and integration with expert technical guidance.

The NORTHERN Customer Support Program brings you closer to the technological front line 
and provides you with the assistance you need to make the most out of being there.

NORTHERN does not just make software - we provide our customers with complete solutions.

FEATURES
NORTHERN’s Customer Support Program offers two different kinds of support: Premium and 
Standard. 

More information about NORTHERN’s Customer Support Program is available at 
www.northern.net/support.

Please contact your local software supplier to find out how you can join NORTHERN’s 
Customer Support Program. A list of authorized NORTHERN resellers is available at 
www.northern.net.
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CONTACTING NORTHERN
Do you have questions? Would you like to comment on our products, support or business? Do 
you have suggestions for future releases or products? Would you like to pay us a visit?

STREET ADDRESS 
Northern Parklife Inc
5201 West Kennedy Blvd Suite#930
Tampa FL 33609
USA

Northern Parklife AB
Gavlegatan 18b
SE-113 30 Stockholm
Sweden

PHONE
US time zones: 1.800.881.4950

1.813.639.0767

Other time zones: +46 8 457 50 00

FAX
US time zones: 1.813.639.0757

Other time zones: +46 8 457 50 50

E-MAIL
Sales inquiries: sales@northern.net
Support questions: support@northern.net
Other: info@northern.net

WEB
www.northern.net
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